Notice of Disclaimer

The information disclosed to you hereunder (the "Materials") is provided solely for the selection and use of Xilinx products. To the maximum extent permitted by applicable law: (1) Materials are made available “AS IS” and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and conditions of the Limited Warranties which can be viewed at http://www.xilinx.com/warranty.htm; IP cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in Critical Applications: http://www.xilinx.com/warranty.htm#critapps.

©Copyright 2012 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Zynq, and other designated brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective owners.

Revision History

The following table shows the revision history for this document.

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/16/2012</td>
<td>2012.3</td>
<td>• Fixed incorrect references to figures 61 and 62 in 2012.2 release.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Renamed Inter-SLR Penalty to Inter-SLR Compensation.</td>
</tr>
<tr>
<td>08/20/2012</td>
<td>2012.2</td>
<td>• Initial Xilinx release.</td>
</tr>
</tbody>
</table>
## Table of Contents

Design Analysis ................................................................................................................................................................................. 5

- Introduction to Design Analysis ......................................................................................................................................................
- Reports and Messages ........................................................................................................................................................................
- Reports .................................................................................................................................................................................................
- Report Timing Summary ...................................................................................................................................................................
- Report Clock Networks ....................................................................................................................................................................
- Report Clock Interaction .................................................................................................................................................................
- Report Pulse Width ...........................................................................................................................................................................
- Report Timing ..................................................................................................................................................................................

Logic Analysis ..................................................................................................................................................................................... 47

- Introduction to Logic Analysis ..........................................................................................................................................................
- RTL Analysis ..........................................................................................................................................................................................
- Netlist Window ..................................................................................................................................................................................
- Hierarchy Window ................................................................................................................................................................................
- Viewing the Schematic ......................................................................................................................................................................

Analyzing Implementation Results ..................................................................................................................................................... 67

- Design Runs Window ........................................................................................................................................................................
- More Analysis ..................................................................................................................................................................................
- Viewing Routing ................................................................................................................................................................................
- Viewing Options ................................................................................................................................................................................
- Navigating in the Device View ........................................................................................................................................................

Timing Analysis .................................................................................................................................................................................... 82

- Introduction to Timing Analysis ........................................................................................................................................................
- Verifying Timing Signoff ....................................................................................................................................................................
- Reading a Timing Path Report ...........................................................................................................................................................
- Closure Techniques ...........................................................................................................................................................................
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to Closure Techniques</td>
<td>93</td>
</tr>
<tr>
<td>Check Input Constraints and Sources</td>
<td>93</td>
</tr>
<tr>
<td>Increasing Tool Effort</td>
<td>95</td>
</tr>
<tr>
<td>Manual Floorplanning</td>
<td>96</td>
</tr>
<tr>
<td>Modify Routing</td>
<td>108</td>
</tr>
<tr>
<td>Modify Logic</td>
<td>109</td>
</tr>
<tr>
<td>Using Modifications</td>
<td>110</td>
</tr>
<tr>
<td>Additional Resources</td>
<td>111</td>
</tr>
<tr>
<td>Xilinx Resources</td>
<td>111</td>
</tr>
<tr>
<td>Solution Centers</td>
<td>111</td>
</tr>
<tr>
<td>References</td>
<td>111</td>
</tr>
</tbody>
</table>
Chapter 1

Design Analysis

Introduction to Design Analysis

This document, the Vivado Design Suite User Guide: Design Analysis and Closure Techniques (UG906), provides an introduction to:

- Understanding the design in the Vivado™ Integrated Design Environment (IDE), including:
  - Messages and reports
  - Design Rules Check (DRC) structure
- Understanding the design in the chip
- Analyzing the timing
- Analyzing Place and Route results
- Techniques to use when the design does not meet its timing goals

For more information about managing windows and using the Vivado IDE, see the Vivado Design Suite User Guide: Using Vivado IDE (UG893) at the location cited under References in Additional Resources at the end of this document.

Reports and Messages

The Vivado IDE generates reports and messages to inform you of events during various tool interactions. Most user-initiated actions generate messages. Review the messages to determine whether the tools are having difficulties in any sections of the design. Messages and reports are stored in the Messages and Reports windows in the Results window area.

In the Messages window, the Vivado IDE groups messages in subfolders by the action that created the message. Use the icons on the local toolbar to order the messages by message ID or file.
Some messages include hyperlinks to a file or a design element to help in debugging. Click the file name or line number to view the source. Use the popup menu to copy messages in full.

### Message Severities

<table>
<thead>
<tr>
<th>Icon</th>
<th>Severity</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>📚</td>
<td>Info</td>
<td>General status of the process and feedback regarding design processing.</td>
</tr>
<tr>
<td>🔴</td>
<td>Warning</td>
<td>Design results may be sub-optimal because constraints or specifications may not be applied as intended.</td>
</tr>
<tr>
<td>🔴</td>
<td>Critical Warning</td>
<td>Certain user input or constraints will not be applied, or are outside the best practices, which usually leads to an error later on in the flow. Examine their sources and constraints. Changes are highly recommended.</td>
</tr>
<tr>
<td>🔴</td>
<td>Error</td>
<td>An issue that renders design results unusable and cannot be resolved without user intervention. The design flow stops.</td>
</tr>
</tbody>
</table>

### Message Filtering

Use message filtering to view the most severe message type for each action. To filter out a message type, click the check mark next to a message severity. If there is a Critical Warning or an Error during design load, the tool may take you to the message tab and filter out the other messages.

### Message Types

There are two types of messages in the tool:

- Messages stored on disk
- Messages stored in memory
New Processes

When you run any of the following commands, the tool starts a new process:

- Run Synthesis
- Run Implementation
- launch_runs (TCL)

The process generates messages and reports that persist on disk until you reset the run. Messages that relate to a run appear when a project is open. The tool displays only the messages for the active run in the Messages window.

Messages Created During Design Load

Messages created while loading one of the following designs appear under the relevant design folder:

- Elaborated Design
- Synthesized Design
- Implemented Design

The folder appears when the design is loaded into memory.

Messages Created During Project Open

Messages appear when you open a project in either the Vivado IDE graphical user interface or in the TCL console. These messages persist only while the design is open.

Message ID Numbers

Messages have unique ID numbers. Use this ID to search the documentation for information about the messages. You may have different message priorities than the tool defaults.

Changing Message Severity

To increase or reduce the severity of a message, run the `set_msg_severity` command. For example:

```
set_msg_severity "Common 17-81" "CRITICAL WARNING"
```
Reports

Reports include:

- Generated Reports
- Vivado Synthesis Report
- Control Sets Report
- DRC Report
- Route Status Report
- Timing Summary Report
- WebTalk Report

Report Sources

Reports result from a variety of actions in the Vivado IDE:

- When you load a design, many different reporting commands are available through the Tools menu.

- Running Synthesis or Implementation creates reports as part of the run.

- Other reports are generated when a design is loaded into memory.

The reports for the active Synthesis and Implementation runs appear in the Reports window. Double click a report to view it in the text viewer. Use the Reports tab of the Run Properties window to view reports of the run selected in the Design Runs window.

Figure 2: Reports Window
Generated Reports

Generated Reports include:

- Reports Generated During Synthesis
- Reports Generated During Placement
- Reports Generated During Route
- Reports Generated During Bitstream Generation

Reports Generated During Synthesis

Reports generated during synthesis include:

- Utilization Report (Post Synthesis)

Reports Generated During Placement

Reports generated during placement include:

- Place and Route Log
- IO Report
- Clock Utilization Report
- Utilization Report (Post Placement)
- Control Sets Report

Reports Generated During Route

Reports generated during route include:

- WebTalk Report
- DRC Report
- Route Status Report
- Timing Summary Report

Reports Generated During Bitstream Generation

Output from bitstream generation is written to the log file. The only report generated during bitstream generation is the WebTalk Report.
Vivado Synthesis Report

The Vivado Synthesis Report is the primary output from the Vivado Synthesis tool including:

- The files processed, which are:
  - VHDL
  - Verilog
  - SystemVerilog
  - XDC
- Parameter settings per cell
- Nets with Multiple Drivers
- Undriven hierarchical pins
- Optimization information
- Black boxes
- Final Primitive count
- Cell usage by Hierarchy
- Runtime and memory usage

Review this report or the proper section of the messages tab for Errors, Critical Warnings and Warnings. The Synthesis tool can issue Critical Warnings and Warnings that become more serious later in the flow.

Utilization Report

The Utilization Report is generated during various steps in the flow by the `report_utilization` command. The report includes the device used for the run and utilization for:

- Slice Logic
  - LUT
  - MuxFx
  - Register
- Memory
  - BlockRam
  - FIFO
- DSP48
- I/O resources
• Clocking Resources, including:
  • BUFGCTRL
  • BUFR
  • BUFHCE
  • MMCME2_ADV
  • PLL2_ADV
• Specific Device Resources, including:
  • STARTUPE2
  • XADC
• Sorted Primitive count by type used
• Black Boxes

When run from the Tcl console, the report can include usage of a particular hierarchical cell when using the -cells option. When run from the Vivado IDE graphical user interface, this information appears in an interactive table.

The numbers may change at various points in the flow, when logic optimization commands change the netlist.

**Place and Route Log**

The Place and Route Log includes:

• Information about the location, netlist, and constraints used.
• Logic optimization task. The tool runs logic optimization routines by default to generate a smaller and faster netlist.
• The placement phases, plus a post-placement timing estimate (WNS and TNS only).
• The router phases, plus several timing estimates and a post-routing timing summary (WNS, TNS, WHS and THS only).
• Elapsed time and memory for each implementation command and phases.

Review this report or the proper section of the messages tab for Errors, Critical Warnings and Warnings. The Placer generates warnings that may be elevated to Errors later in the flow. If using Stepwise runs, the log contains only the results for the last step.

**IMPORTANT:** Review the Timing Summary Report to view: (1) the Pulse Width timing summary, and (2) additional information about timing violations or missing constraints.
IO Report

The IO Report replaces the ISE PAD file. The IO Report lists:

- Pin Number
  All the pins in the device
- Signal Name
  The name of the user IO assigned to the pin
- Pin Usage
  The type of pad or buffer used by the pin
- Pin Name
  Name of the pin
- Direction
  Whether the pin is an input, output, inout, or unused
- IO Standard
  The IO standard for the User IO
  An asterisk (*) indicates that it is the default. This differs from the IO Ports window of the Vivado IDE.
- IO Bank Number
  The IO Bank where the pin is located
- Drive (mA)
  The drive strength in milliamps
- Slew Rate
  The Slew Rate configuration of the buffer: Fast or Slow
- Termination
  The off chip termination settings
- IOB Delay
  Delay value set for this pin
- Voltage
  The values for various pins, including VCCO, VCCAUX, and related pins
- Constraint
  Displays **Fixed** if the pin has been constrained by the user
• IOB Sequential Element
  The Flip Flops packed into the IO Bank next to the given port

• Signal Integrity
  The Off-Chip Termination setting

Clock Utilization Report

The Clock Utilization Report helps you analyze the utilization of clock resources inside the device. It can be useful for debugging clock placement issues. The Clock Utilization Report displays:

• The number of clocking primitives available, occupied and constrained
• Loading and skew per BUFG
  Look for nets with large maxdelay and skew.
• Loading and skew per MMCM
  Look for nets with unexpected loading, large maxdelay, and skew.

Regional Clocks Regional clock networks are clock networks independent of the global clock network. Unlike global clocks, the span of a regional clock signal (BUFR) is limited to one clock region. One I/O clock signal drives a single bank. These networks are especially useful for source-synchronous interface designs. The I/O banks in Xilinx® 7 series FPGA devices are the same size as a clock region.

Local Clocks Local clocks are clock networks routed onto general routing resources. Avoid local clocks where possible. They can experience very large clock skew, and are more susceptible to PVT variations. The tools may route the clock differently each time you rerun implementation.

The Locked column for the clocking resources shows whether you placed the clock, or whether the tools are free to place the clocking resource.

If there are too many global clocks, consider moving low fanout global clocks to other clocking resources, such as, for example, BUFH or BUFR.

Control Sets Report

A control set is the unique combination of a clock signal, a clock enable signal, and a set/reset signal. Each slice supports at most one control set which any Flip Flop located in it can use. Flip flops with different control sets cannot be placed in the same slice.

The Control Sets Report lists the number of unique control sets in the design. Based on the placement of the designs, the tool displays the minimum number of register sites lost to the control set packing.

• Clock Signal
  The logical clock signal name
• Enable Signal
  The logical clock enable signal name

• Set/Reset Signal
  The logical set/reset signal name

• Slice Load Count
  The number of unique slices that contain cells connected to the control set

• BEL Load Count
  The number of cells connected to the control set

DRC Report

The DRC Report is generated by the router. Before the router runs, the tool checks for a common set of design issues. The report lists the checks used in the run. Review the Critical Warnings. The severity of a particular check may be increased later in the flow.

Route Status Report

The Route Status report displays:
• The number of nets in the design
• The number of nets that do not use routing resources outside of a tile, including:
  • CLB
  • BlockRam
  • IO Pad
• The number of nets that do need routing resources

For a design to be fully routed this report should show:

  # of unrouted nets............ : 0 :

Timing Summary Report

The Timing Summary report shows whether a design met timing. This is the equivalent of the ISE TWR. The report includes the following sections.

Summary

Summary shows the following:
• Design name
• Part
• Speedfile
• Vivado IDE version
• Time generated
• Command line

Timer Settings

Timer Settings shows the configuration of the timing engine used for generating this report.

Check Timing

Check Timing shows missing or suspicious timing constraints.

Design Timing Summary

The Design Timing Summary shows whether the design met the constraints. When any TNS, THS, or TPWS is not 0ns, the design did not meet timing.

Clock Summary

The Clock Summary shows a report of each clock defined by the user or by the timing engine, its waveform, period, and requested frequency.

Intra Clock Table

The Intra Clock Table is a summary of the timing on paths within a clock domain.

Inter Clock Table

The Inter Clock Table is a summary of timing for each clock domain crossing.

Path Group Table

The Path Group Table is a timing summary for each path group other than the default clock ones. This includes all the asynchronous timing check reports (recovery/removal), as well as user defined groups (see the \texttt{group_path} command)

Timing Details

Timing Details provides the details of the N-worst timing paths reported for each clock pair in the Intra-Clock, Inter-Clock, and Path Group sections

After an implementation run finishes, you must manually open the report. The tool does not open it for you. Use the Report Timing Summary dialog box to create an interactive report in the Vivado IDE.
WebTalk Report

The WebTalk Report is generated during Route and Bitstream. The report collects information about how you use Xilinx parts. This helps Xilinx provide you with better software. No proprietary information is collected. For more information, go to http://www.xilinx.com/ise/webtalk/

On Demand Reports

To generate other reports, you must first load the design in memory. Commonly used reports are available from the Flow Navigator.

Elaborated Design

- Report DRC
- Report Noise
- Report Power

Synthesized and Implemented Design

- Report Timing Summary
- Report Clock Networks
- Report Clock Interaction
- Report DRC
- Report Noise
- Report Utilization

Implemented Design has all the reports in Synthesized design plus Report Power.

You can also select Tools > Timing to generate timing-related reports. For example, when a Synthesized Design is loaded in memory, you have access to:

- Report Timing
- Report Timing Summary
- Report Pulse Width
- Report Clock Interaction

The following sections give more information on each of the reports, including:

- How to run the report.
- The information it provides.

TIP: Not all reports are useful at all steps in the flow. RTL Analysis supports only a subset of the reports.
Report DRC

Report DRC runs common Design Rule checks to look for common design issues and errors.

Elaborated Design

The tool checks for DRCs related to IO and Clock Placement. The RTL netlist typically does not have all the IO Buffers, Clock Buffers, and other primitives the post synthesis designs have. Elaborated Design DRCs do not check for as many errors as later DRCs.

Synthesized Design and Implemented Design

- Checks for DRCs related to the post synthesis netlist.
- Checks IO, BUFG, and other placement.
- Basic checks on the attributes wiring on MGTs, IODELAYs, and other primitives.
- The same DRCs run taking into account any available placement and routing.
- DRCs have the same four severities as Messages. Critical Warnings and Errors do not block the flow at this point.

Steps of the implementation flow also run the DRCs, which can stop the flow at critical points. The placer and router check for issues that block placement. Certain messages have a lower severity depending on the stage. These are DRCs flagging conditions that do not stop opt_design, place_design, or route_design from completing, but which can lead to issues on the board.

For example, some DRCs check that the user has manually constrained the package pin location and the IO standard for all design ports. If some of these constraints are missing, place_design and route_design issue critical warnings. However, these DRCs appear as an ERROR in write_bitstream. The tools will not program a part without these constraints.

The decreased severity earlier in the flow allows you to run the design through implementation iterations before the final pinout has been determined. You must run bitstream generation for a comprehensive DRC signoff.
The following figure (DRC Report) shows the Vivado IDE graphical user interface form of Report
DRC.

![Figure 3: DRC Report](image)

Click a DRC to open the properties for a detailed version of the message. Look in the Properties
window to see the details. Most messages have a hyperlink for nets, cells, and ports referenced
in the DRC.

![Figure 4: DRC Properties](image)
The DRC report is static. You must re-run Report DRC for the report to reflect design changes. The tool determines that the links are stale after certain design operations (such as deleting objects and moving objects), and invalidates the links.

Selecting an object from the hyperlink selects the object, but does not refresh the Properties window. To see the properties for the object, you must unselect and reselect it.

To create a DRC report in Tcl, run:

```
report_drc
```

To send the results to a file, run:

```
report_drc -file myDRCs.txt
```

**TIP:** For more information on the `report_drc` command, run `report_drc -help`.

### Noise Report

Performs the Simultaneous Switching Noise (SSN) calculation for Xilinx 7 series FPGA devices. By default, the SSN report opens in a new tab in the Results window area of the Vivado IDE. You can export the results to a CSV or HTML file.

![Run SSN Analysis Dialog Box](image)

**Figure 5: Run SSN Dialog Box**
The Noise Report has four sections:

- Summary
- Messages
- I/O Bank Details
- Links

Summary

The Summary section includes:

- When the report ran
- Number and percentage of applicable ports analyzed
- Status, including whether it passed
- Number of Critical Warnings, Warnings, and Info messages

Messages

The Messages section includes a detailed list of the messages generated during the report.

I/O Bank Details

The I/O Bank Details section includes a list of Pins, Standards, and Remaining Margin.

Links

The Links section contains links to relevant documentation on www.xilinx.com/support.

![Figure 6: Noise Report](image_url)
To create an HTML version of the report, select the option or run the following Tcl command:

```
report_ssn -format html -file myImplementedDesignSSN.html
```

## Power Report

Report Power is available when a Synthesized Design or an Implemented Design is open. The report estimates power consumption and junction temperature based on design inputs including:

- Thermal statistics, such as junction and ambient temperature values.
- Data on board selection, including number of board layers and board temperature.
- Data on the selection of airflow and the head sink profile used by the design.
- Reporting the FPGA current requirements from the different power supply sources.
- Allowing detailed power distribution analysis to guide power saving strategies and to reduce dynamic, thermal or off-chip power.
Analyzing the Power Report

You can analyze the Power Report, shown in the figure above, based on:

- Settings
- Power total
• By hierarchy
• Per Voltage rail
• By block type

![Power Report](image)

**Figure 8: Power Report**

For more information on the power report and analyzing the results, see *Power Analysis and Optimization (UG907)* at the location cited under References in Additional Resources at the end of this document.

**Reporting Power in a Non-Project Flow**

In the non-project flow, `report_power` is available after `link_design` or `synth_design`. The report uses the available placement and routing to give more accurate power numbers. To generate this report from the Tcl Console or a script, run the following command:

```tcl
report_power
```
Report Timing Summary

Timing analysis is available anywhere in the flow after synthesis. You can review the Timing Summary report files automatically created by the Synthesis and Implementation runs.

If your synthesized or implemented design is loaded in memory, you can also generate an interactive Timing Summary report from the Flow Navigator, under Synthesis or Implementation, or from the menu Tools > Timing > Report Timing Summary. The equivalent Tcl command is report_timing_summary.

For more information on the options of this command, see the Vivado Design Suite Tcl Reference Guide (UG835) at the location cited under References in Additional Resources at the end of this document.

In a Synthesized Design, the Vivado IDE timing engine estimates the net delays based on connectivity and fanout. The accuracy of the delays is greater for nets between cells that are already placed by constraints.

In an Implemented Design, the net delays are based on the actual routing information. You must use the Timing Summary report for timing signoff if your design is completely routed, which you can verify by reading the Route Status report.

Report Timing Summary Dialog Box Options

In the Vivado IDE, the Report Timing Summary dialog box includes the following tabs:

- Options
- Advanced
- Timer Settings

You can choose to open the results in a new window by specifying its name in the Results name field. If this field is empty, the report is printed in the Tcl Console. You can also delete the reports previously created by unchecking Open in a new tab at the bottom of the dialog box.

The equivalent report_timing_summary options are listed along the dialog options in the following section.
Options Tab

The following figure (Report Timing Summary Dialog Options Tab) shows the Options tab in the Report Timing Summary dialog box.

The following options are available in the Options tab:

- Reports
- Path Limits
- Path Display
Reports

- **Path delay type**: Sets the type of analysis to be run. For synthesized designs, only max delay analysis (setup/recovery) is performed by default. For implemented design, both min and max delay analysis (setup/hold, recover/removal) are performed by default. You can elect to run min delay analysis only (hold and removal) by selecting the min value.
  
  Equivalent Tcl option: `-delay_type`

- **Path report format**: Controls the amount of detail displayed for each reported timing path.
  
  Equivalent Tcl option: `-path_type`

- **Report unconstrained paths**: Generates information on paths that do not have timing requirements. This option is checked by default in the Vivado IDE, but is not turned on by default in the equivalent Tcl command `report_timing_summary`.
  
  Equivalent Tcl option: `-report_unconstrained`

Path Limits

- **Maximum number of paths per clock or path group**: Controls the maximum number of paths reported per clock pair or path group.
  
  Equivalent Tcl option: `-max_paths`

- **Maximum number of worst paths per endpoint**: Controls the maximum number of paths potentially reported per path endpoint. This limit is bounded by the maximum number of paths per clock pair or path group.
  
  Equivalent Tcl option: `-nworst`

Path Display

- **Display paths with slack less than**: Filters the reported paths based on their slack value. This option does not affect the content of the summary tables.
  
  Equivalent Tcl option: `-slack_lesser_than`

- **Number of significant digits**: Controls the accuracy of the numbers displayed in the report.
  
  Equivalent Tcl option: `-significant_digits`
Advanced Tab

The following figure (Report Timing Summary Dialog Advanced Tab) shows the advanced tab in the Report Timing Summary dialog box.

The following options are available:

- **Pins**: Shows input pins in the path details. Xilinx recommends that you keep this option selected.
  
  Equivalent Tcl option: `-input_pins`

- **File Output**: Redirects the output of the command to a file, and optionally appends it to an existing report file.
  
  Equivalent Tcl options: `-file` and `-append`

- **Miscellaneous**:
  
  - **Ignore command errors**: Forces the tool to ignore any error.
    
    Equivalent Tcl option: `-quiet`

  - **Suspend message limits during command execution**: Turns on the verbose mode.
Equivalent Tcl option: `-verbose`

**Timer Settings Tab**

To set the timer settings, use either the dialog box or the Tcl Console. These settings affect other timing-related commands run in the same Vivado IDE session, except the synthesis and implementation ones. The timer settings are not saved as tool preference, and the default values are restored for each new session.

**RECOMMENDED:** Do not change the default values. Keeping the default values provides maximum timing analysis coverage with the most accurate delay values.

The following figure (Report Timing Summary Dialog Timer Settings Tab) shows the Timer Settings tab in the Report Timing Summary dialog box.

![Report Timing Summary Dialog Timer Settings Tab](image)

**Figure 11: Report Timing Summary Dialog Timer Settings Tab**

The following options are available in the Timer Settings tab:

- Interconnect
- Speed Grade
- Multi-Corner Configuration
Interconnect

Interconnect controls how the net delays are calculated. This option is automatically set to **Estimated** for post-synthesis designs and to **Actual** for post-implementation designs.

- **Estimated**
  
  For unplaced cells, the net delay value corresponds to the delay for the best possible placement, based on the nature of the driver and loads as well as the fanout. This net is labeled *unplaced* in the timing path report.

  For placed cells, the net delay depends on the distance between the driver and the load as well as the fanout. This net is labeled *estimated* in the timing path report.

- **Actual**
  
  For routed nets, the net delay corresponds to the actual hardware delay. This net is labeled *routed* in the timing path report.

  For unrouted nets between placed cells, the net delay depends on the distance between the driver and the load as well as the fanout. This net is labeled *estimated* in the timing report.

- **None**
  
  The net delays are forced to zero.

  **Equivalent Tcl command:** `set_delay_model`

Speed Grade

Speed Grade sets the speed grade. By default, this option is set based on the part selected when creating a project or opening a design checkpoint. You can change this option to report timing on the same design database against another speed grade without re-running the complete implementation flow.

**Equivalent Tcl command:** `set_speed_grade`

Multi-Corner Configuration

Multi-Corner Configuration specifies the analysis to run for each corner, whether setup (max), hold (min), or both.

**RECOMMENDED:** Always keep both setup (max) and hold (min) analysis selected for both corners.

**Equivalent Tcl command:** `config_timing_corners`

**Timing Summary Report Sections**

The Report Timing Summary contains the following sections:

- **General Information**
• Timer Settings
• Design Timing Summary
• Check Timing
• Clock Summary
• Intra-Clock Paths
• Inter-Clock Paths
• Path Groups
• Unconstrained Paths

The comprehensive information contained in the Timing Summary Report is similar to the information provided by several reports available from the Vivado IDE (Report Clock Interaction, Report Pulse Width, Report Timing, Check Timing) and to some of the reports available in Tcl only (report_clocks). However, the Report Timing Summary also includes information that is unique to this report, such as Unconstrained Paths.

General Information

The General Information section provides information about the following:

• Design name
• Selected device, package, and speed grade (with the speed file version)
• Vivado Design Suite release
• Current date
• Equivalent Tcl commands executed to generate the report

Timer Settings

The Timer Settings section contains details on the Vivado timing analysis engine settings used to generate the timing information in the report. The following figure (Timing Summary Report Timer Settings) shows an example of the Timer Settings section, which includes:

• Enable Multi-Corner Analysis and which analysis is enabled for each corner (Multi-Corner Configuration).

• **Enable Pessimism Removal (and Pessimism Removal Resolution):** This setting must always be enabled. It insures that the source and destination clocks of each path are reported with no skew at their common node.

• **Enable Input Delay Default Clock:** This option creates a default null input delay constraint on input ports with no user constraint. It is disabled by default.

• **Enable Preset / Clear Arcs:** This option enables timing path propagation through asynchronous pins. It does not affect recovery/removal checks and is disabled by default.
Design Timing Summary

The Design Timing Summary section provides a summary of the timing for the design, and combines the results of all other sections in one view.

**RECOMMENDED:** Review the Design Timing Summary section to verify that all timing constraints are met after route, or to understand the status of the design at any point in the flow:

### Setup

Setup includes all checks related to max delay analysis: setup, recovery and data check.

- **WNS (Worst Negative Slack):** This value corresponds to the worst slack of all the timing paths for max delay analysis. It can be positive or negative.

- **TNS (Total Negative Slack):** This value is the sum of all WNS violations, when considering only the worst violation of each timing path endpoint. Its value is 0ns when all timing constraints are met for max delay analysis, or negative when there are some violations.

- **Failing Endpoints:** This is the total number of endpoints with a violation (WNS<0ns).

### Hold

Hold includes all checks related to min delay analysis: hold, recovery and data check.

- **WHS (Worst Hold Slack):** This value corresponds to the worst slack of all the timing paths for min delay analysis. It can be positive or negative.
• **THS** (Total Hold Slack): This value is the sum of all WHS violations, when considering only the worst violation of each timing path endpoint. Its value is 0ns when all timing constraints are met for min delay analysis, or negative when there are some violations.

• **Failing Endpoints**: This is the total number of endpoints with a violation (WHS<0ns).

**Pulse Width**

Pulse Width includes all checks related to pin switching limits:

- Min low pulse width
- Min high pulse width
- Min period
- Max period
- Max skew (between two clock pins of a same leaf cell). The WPWS value corresponds to the worst pulse width slack for all the checks listed above with min and max and delays. The TWPS value is the sum of all WPWS violations, when considering only the worst violation of each timing path endpoint. Its value can only be 0ns or negative.

The three reported values are:

• **WPWS** (Worst Pulse Width Slack): This value corresponds to the worst slack of all the timing checks listed above when using both min and max delays.

• **TPWS** (Total Pulse Width Slack): This value is the sum of all WPWS violations, when considering only the worst violation of each pin in the design. Its value is 0ns when all related constraints are met, or negative when there are some violations.

• **Failing Endpoints**: This is the total number of pins with a violation (WPWS<0ns).

The following figure (Timing Summary Report Design Timing Summary) shows an example of the Design Timing Summary section.

![Figure 13: Timing Summary Report Design Timing Summary](image)

**Clock Summary**

The Clock Summary section contains information similar to that produced by the `report_clocks` command. It shows all the clocks that exist in the design (created by `create_clock`, `create_generated_clock`, or automatically by the tool). It also includes
the properties for each clock, such as name, period, waveform, type, and target frequency. The indentation of names reflects the relationship between master and generated clocks.

The following figure (Timing Summary Report Clock Summary) shows an example of the Clock Summary section.

![Clock Summary]

Figure 14: Timing Summary Report Clock Summary

Check Timing

The Check Timing section contains useful information about missing timing constraints or paths with constraints issues that need to be reviewed. For complete timing signoff, all path endpoints must be constrained. You can also generate this report independently from the menu (Tools > Timing > Check Timing) or with the `check_timing` command.

The list of checks reported by default is as follows:

- **no_clock**: Number of clock pins not reached by a defined timing clock. Constant clock pins are also reported.
- **unconstrained_endpoints**: Number of path endpoints without a timing requirement. This number is directly related to missing clock definitions, which is also reported by the “no_clock” check.
- **no_input_delay**: Number of input ports without at least one input delay constraint.
- **no_output_delay**: Number of output ports without at least one output delay constraint.
- **multiple_clock**: Number of clock pins reached by more than one timing clock. This usually happens when there is a clock multiplexer in one of the clock trees.
- **loops**: Number of combinational loops found in the design. The loops are automatically broken by the Vivado timing engine in order to report timing.
- **generated_clocks**: Number of generated clocks that refer to a master clock source which is not part of the same clock tree.

- **partial_input_delay**: Number of input ports with only a min input delay or max input delay constraint. These ports are not reported by both setup and hold analysis.

- **partial_output_delay**: Number of output ports with only a min output delay or max output delay constraint. These ports are not reported by both setup and hold analysis.

- **unexpandable_clocks**: Clock pairs for which the Vivado timing engine could not find a common period multiplier over 1000 clock cycles. The paths between these clock pairs cannot be safely timed and the clock pairs must be treated as asynchronous.

For more information on constraints definition, see the *Vivado Design Suite Using Constraints User Guide (UG903)* at the location cited under References in Additional Resources at the end of this document.

### Intra-Clock Paths

The Intra Clock Paths section summarizes the worst slack and total violations of the timing paths with the same source and destination clocks. The following figure (Timing Summary Report Intra-Clock Paths) shows an example of the Intra-Clock Paths section.

![Intra-Clock Paths](image)

**Figure 15: Timing Summary Report Intra-Clock Paths**

From the index pane on the left, you can click the names under Intra-Clock Paths to view detailed information. For example, you can view the slack and violations summary for each clock and details about the N-worst paths for SETUP/HOLD/Pulse Width checks.
Next to the label for each analysis type, the worst slack value and the number of reported paths are shown. See the following figure (Timing Summary Report Intra-Clock Paths Details).

Inter-Clock Paths

Similar to the Intra-Clock Paths section, the Inter-Clock Paths section summarizes the worst slack and total violations of timing paths with different source and destination clocks. The following figure (Timing Summary Report Inter-Clock Paths Summary) shows an example of the Inter-Clock Paths section.

From the index pane on the left, you can click the names under Inter-Clock Paths to view detailed information. For example, you can view the slack and violations summary for each clock and details about the N-worst paths for SETUP/HOLD/Pulse Width checks.
Next to the label of each analysis type, the worst slack value and the number of reported paths are shown. See the following figure (Timing Summary Report Inter-Clock Paths Details).

**Path Groups**

The Path Groups section shows default path groups and user-defined path groups. The following figure (Timing Summary Report Path Groups) shows an example of the Path Groups summary table which you can access by selecting **Path Groups** in the left pane.

**Note** **async_default** is a path group automatically created by the Vivado timing engine. It includes all paths ending with an asynchronous timing check, such as recovery and removal. These two checks are respectively reported under SETUP and HOLD categories, which corresponds to max delay analysis and min delay analysis. Any groups you create using the **group_paths** command appear in this section as well. Any combination of source and destination clocks can be present in a path group.

**Unconstrained Paths**

The Unconstrained Paths section shows the logical paths that are not timed due to missing timing constraints or because you added timing exceptions to ignore some path. These paths
are grouped by source and destination clock pairs. The clock name information shows empty (or NONE) when no clock can be associated with the path startpoint or endpoint.

The following figure (Timing Summary Report Unconstrained Paths) shows an example of the Unconstrained Groups section summary.

![Figure 20: Timing Summary Report Unconstrained Paths](image)

### Reviewing Timing Path Details

You can expand most of the sections to show paths organized by clock pairs. For each SETUP, HOLD and Pulse Width sub-section, you can see the N-worst reported paths. When selecting any of these paths, you can see more details in the Path Properties window (Report tab). You can also see the same details in a new window when you double click on the path. You can find more information on timing path details in Chapter 4, Timing Analysis.

To access more analysis views for each path, right click the path in the right pane, and select one of the following options from the popup menu:

- Open a Schematic of the path.
- Re-run timing analysis on this same path.
- Highlight the path in the Device and Schematic windows.
Filtering Paths With Violation

The report shows the slack value of failing paths in red. You can focus on these violations by activating the **Show only failing checks** mode (button: ![checkmark]). The following figure (Timing Summary Report Violating Paths Filter) shows the Timing Summary window with only violating paths.

![Timing Summary Report Violating Paths Filter](image)

**Figure 21: Timing Summary Report Violating Paths Filter**

---

Report Clock Networks

Report Clock Networks provides a tree view of the clocks trees in the design.

- From IO port to load.
- Shows Clock names for clocks defined by the user or automatically by the tool.
- The full tree details only appear in the GUI. The text version of this report only shows the name of the clock roots.
- Used to find BUFG driving BUFG.
- Clocks driving not clock loads.

There is a folder containing each primary clock and its generated clocks, if any, defined in the design. A separate folder shows each unconstrained clock root.

Each tree shows the clock network from source to endpoint with the endpoints sorted by type.
Use the Filter Ports, Nets, Instances, and related buttons to reduce the amount of data displayed in the clock tree. Selecting an object in the tree and running the Trace to Source popup command produces a schematic of the clock path.

Run the following command to generate the report from the Tcl console and populate the GUI:

```
report_clock_networks -name {network_1}
```

---

**Report Clock Interaction**

Report Clock Interaction:

- Analyzes inter-clock timing paths.
- Shows them on a grid.
  - Green – Fully Constrained
  - Black – No paths
  - Red – User False path constraints cover all cross domain paths
  - Yellow – User False Path constraints cover some of the cross domain paths
- Helps to identify cases in which there may be data loss or metastability issues.
Run the following to create a Clock Interaction report to display in the Vivado IDE via Tcl:

```
report_clock_interaction -delay_type max -significant_digits 2 -name timing_1
```

---

**Report Pulse Width**

The pulse width report checks that the design meets min period, max period, high pulse time, and low pulse time requirements for each instance clock pin. It also checks that the maximum skew requirement is met between two clock pins of a same instance in the implemented design (for example: PCIE clocks).

**Note:** ISE implementation calls this check Component Switching Limits.
To generate this report from the Tcl console run:

```
report_pulse_width -name timing_1
```

**Per Session Reports**

The `vivado.exe` process creates the `vivado.log` and `vivado.jou` in the directory you were in when you started the process. The `vivado.exe` process initializes the LOG and JOU files before the Vivado IDE starts. Select **File > Open Log File** and **File > Open Journal File** to see the LOG and JOU files at any time.

**Report Timing**

You can read Report Timing to view specific timing paths at any point of the flow after synthesis when you need to investigate timing problems reported by Report Timing Summary or when you want to report the validity and the coverage of particular timing constraints. Report Timing does not cover Pulse Width reports.

You can run Report Timing from various places in the Vivado IDE, assuming a design is already loaded in memory:

- From the menu: Select **Tools > Timing > Report Timing**.
- From the Clock Iteration Report: Select a from/to clock pair, right-click, and select **Report Timing** to run a report from or to the selected clocks.
- From the Timing Report and Timing Report Summary paths list: Select a path, right-click and select **Report Timing** to run a report between the selected path startpoint endpoint.

The equivalent Tcl command is `report_timing`. When setting specific Report Timing options, you can see the equivalent `report_timing` command syntax in the Command field at the bottom of the dialog and in the Tcl Console after execution. The `report_timing` options are listed along with the dialog description in the following section.
Overall, the Report Timing options are identical to the Report Timing Summary options, plus a few additional options.

**Targets Tab**

Report Timing provides several filtering options that you must use in order to report a particular path or group of paths. The filters are based on the structure of a timing path:

- **Start Points (From)**: List of start points, such as sequential cell clock pins, sequential cells, input ports, bidirectional ports or source clock. If you combine several start points in a list, the reported paths will start from any of these netlist objects. The Rise/Fall filter selects a particular source clock edge.

  Equivalent Tcl option: `-from`, `-rise_from`, `-fall_from`

- **Through Point Groups (Through)**: List of pins, ports, combinational cells or nets. You can combine several netlist objects in one list if you want to filter on paths that traverse any of them. You can also specify several Through options if you need to refine your filters and report paths that traverse all through points. The Rise/Fall filter applies to the data edge.

  **RECOMMENDED:** Use the default value (Rise/Fall).

  Equivalent Tcl option: `-through`, `-rise_through`, `-fall_through`

- **End Points (To)**: List of endpoints, such as input data pins of sequential cells, sequential cells, output ports, bidirectional ports or destination clock. If you combine several endpoints in a list, the reported paths will end with any of these netlist objects. In general, the Rise/Fall option selects a particular data edge. But if you specified a destination clock, it selects a particular clock edge.

  Equivalent Tcl option: `-to`, `-rise_to`, `-fall_to`
The following figure (Report Timing Dialog Targets Tab) shows the Targets tab in the Report Timing dialog box, where the path filters have been set to returns path from the rising clock edge of cpuClk, through any if the u4/data[*] nets and to the falling edge of fftClk or sysClk.

Figure 25: Report Timing Dialog Targets Tab

**Options Tab**

The following options are available in the Options tab:

- Reports
- Path Limits
- Path Display

Reports

- **Do not report unconstrained paths:** by default, Report Timing reports paths that are not constrained if no path that matches the filters (from/through/to), is constrained. Check this box if you do not want to see unconstrained paths in your report.

  Equivalent Tcl option: `-no_report_unconstrained`

### Path Limits

- **Number of paths per group:** See Report Timing Summary, page 24.
- **Number of paths per endpoint:** See Report Timing Summary, page 24.
- **Limit paths to group:** Filters on one or more timing path groups. Each clock is associated to a group. The Vivado IDE timing engine also creates a few default groups such as `**async_default**` which groups all the paths ending with a recovery or removal timing check.

  Equivalent Tcl option: `-group`

### Path Display

- **Display paths with slack greater than:** Filters the reported paths based on their slack value.
- **Equivalent Tcl option:** `-slack_greater_than`
- **Display paths with slack less than:** See Report Timing Summary.
- **Number of significant digits:** See Report Timing Summary.
- **Sort paths by:** Choose to display the reported paths by group (default) or by slack. When sorted by group, the N worst paths for each group and for each type of analysis (`-delay_type min/max/min_max`) are reported. The groups are sorted based on their individual worst path so that the group with the worst violation shows at the top of the list. When sorted by slack, the N worst paths per type of analysis are reported (all groups combined) and sorted by increasing slack.

  Equivalent Tcl option: `-sort_by`

### Advanced Tab

Same options as Report Timing Summary.

### Timer Settings Tab

Same options as Report Timing Summary.

### Reviewing Timing Path Details

After clicking **OK** to run the report command, a new window opens and you can start reviewing its content. You can see the N-worst paths reported for each type of selected analysis.
(min/max/min_max). The following figure (Report Timing Window) shows the Report Timing window where both min and max analysis (SETUP and HOLD) were selected, and N=4.

![Figure 26: Report Timing Window](image)

When selecting any of these paths, you can see more details in the Path Properties window (Report tab). The following figure (Timing Path Properties) shows a Path Properties window.

![Figure 27: Timing Path Properties](image)
You can also see the same details in a new window when you double click on the path. You can find more information on timing path details in Chapter 4, Timing Analysis. The figure above (Timing Path Properties) shows a Timing Path report window.

To access more analysis views for each path, you can right click on the path in the right pane, and select one of the following actions from the popup menu:

- View the timing path Schematic.
- Re-run timing analysis on the same startpoint and endpoint of the selected path.
- Highlight the path in the Device and Schematic windows.

**Filtering Paths With Violation**

The report shows the slack value of failing paths in red. To focus on these violations, click the **Show only failing checks mode** button ( ).
Chapter 2

Logic Analysis

Introduction to Logic Analysis

This chapter contains information on:

- The elements in a netlist
- The netlist connectivity
- Searching for gates and primitive types
- Design flow in a chip
- Utilization
- Common design issues using DRC

RTL Analysis

For information about RTL Analysis, see the *Vivado Design Suite User Guide: System-Level Design Entry (UG895)* at the location cited under References in Additional Resources at the end of this document.

Netlist Window

The Netlist Window shows the design hierarchy as it is in the netlist, processed by the synthesis tools.
Depending on synthesis settings, the netlist hierarchy may be a one hundred percent match for the original RTL, or there may be no hierarchy. Generally, the synthesis tools default to preserving most of the user hierarchy while optimizing the edges, giving a smaller faster netlist. With the Synthesis tool defaults, the netlist hierarchy is recognizable, but the interfaces to the hierarchies may be modified. Some ports and levels of hierarchy may be missing.

Each level of hierarchy shows its hierarchy tree. At each level, the tool shows:

- A nets folder for any nets at that level
- A primitives folder if there are primitives at that level
- Any hierarchies instantiated at that level

Traversing the tree shows the whole branch. The icons next to the cells and primitives display information about the state of the design.

For more information, see Using the Netlist Window in the *Vivado Design Suite User Guide: Using Vivado IDE (UG893)* at the location cited under References in Additional Resources at the end of this document.
The Properties Window for each level of hierarchy shows utilization statistics including:

- Primitive usage for the whole hierarchical branch, grouped in higher level buckets
- The number of nets crossing the hierarchy boundary
- Clocks used in the hierarchy

![Instance Properties Window](image)

Figure 29: Instance Properties Window

If you floorplan the design, similar properties are displayed for the Pblock.
Hierarchy Window

Explore the hierarchy to understand resource usage. To open the Hierarchy Window, select Tools > Show Hierarchy.

The Hierarchy Window displays the hierarchy tree for the netlist. Each horizontal row displays a level of hierarchy inside the netlist. As you move down the rows, you move into deeper netlist hierarchy. Across the row, each level of hierarchy is sized relative to the other hierarchy at that level.

The figure above (Hierarchy Window) shows that cpuEngine, usbEngine0, and usbEngine1:

- Have most of the logic in the design.
- All use about the same number of resources.

The Utilization Report:

- Breaks apart the design based on resource type.
- Displays each resource type independently with consumption per level of hierarchy.

To view the Utilization Report, select Tools > Report Utilization.
In this design, the two `usbEngine` blocks are the two biggest consumers of the RAMB36 and FIFO36 blocks. Click the + (plus) icon to view the consumption at sub-hierarchies.

### Viewing the Schematic

The schematic is a graphical representation of the netlist. View the schematic to:

- View a graphical representation for the netlist.
- Review the gates, hierarchies, and connectivity.
- Trace and expand cones of logic.
• Analyze the design.
• Better understand what is happening inside the design.

At the RTL level in Elaborated Design, you see how the tool has interpreted your code. In Synthesize Design and Implemented Design, you see the gates generated by the synthesis tool.

To open the schematic, select Tools > Schematic. If nothing is selected, the gates, hierarchy, and connectivity appear at the top level of the design.

Figure 32: Top Level Schematic

For information about zooming and moving around the schematic, see the Vivado Design Suite User Guide: Using Vivado IDE (UG893) at the location cited under References in Additional Resources at the end of this document.
**TIP:** The schematic is simpler if you use a single level of hierarchy only. The schematic populates with the selected element emphasized (blue). The ports for the single hierarchy display.

![Figure 33: Schematic with Single Hierarchy Selected](image-url)
You can trace the schematic in multiple ways:

- Click the + (plus) icon in the upper right to display the gates in the hierarchy.
- Double click a port or element to expand it.
- Use the schematic popup.
- For more information, see Using the Schematic Window in the *Vivado Design Suite User Guide: Using Vivado IDE (UG893)* at the location cited under References in Additional Resources at the end of this document.
- Click the < - -> arrows to switch between the previous and next schematic views.
- Select **Expand All** to see more logic and connectivity.
- Select **Collapse All** to simplify the schematic.

After implementation, the schematic is the easiest way to visualize the gates in a timing path. Select the path, then open the schematic with the gates and nets from that path.

![Figure 34: Schematic With Timing Path](image)

To identify the relevant levels of hierarchy in the schematic, choose **Select Primitive Parents** from the popup menu.
As you review the schematic, select the **Highlight** and **Mark** commands to track gates of interest. Color coding primitives (using either a mark or a highlight) makes it easier to track which logic was in the original path, and which logic was added.
Searching for Objects Using Find

The Vivado™ IDE includes powerful find and search capabilities using Edit > Find.

![Figure 37: Edit Find Dialog Box](image)

Find Criteria

Select Edit > Find to search the netlist for:

- Instances
- Nets
- I/O Ports
- Instance Pins
- Pblocks
- RPMs

Find Sub Criteria

There are multiple sub criteria for each of the Find criteria. For example, instance has the following sub criteria:

- Type
- Cell types
- Black boxes
- Primitives, including
  - I/O Buffer
• Block Arithmetic
• Block Memory
• LUT
• Name
• Status
• Parent Pblock
• Module
• Primitive count
• Attribute

Review the other Find criteria for their sub fields.

Device-Specific Find Criteria

Device-specific Find criteria are:
• Arcs
• Nodes
• BEL Pins
• BELs
• Site Pins
• Sites
• Tiles
• I/O Banks
• Clock Regions

Find Examples

Select Edit > Find to find, for example:
• All unplaced IOs
• Only the tool-placed Global Clocks
• All nets with a fanout over 10,000
• All DSPs using the PREG embedded register
Complex Finds

To run a complex find:
1. Set the first search criterion.
2. Click +.
3. Add additional criteria.
4. Join the additional criteria with logical operators (and, or).

TCL Finds

Run the TCL Find commands when running from a script or in the TCL console.
For more information, see the Vivado Design Suite User Guide: Using the Tcl Scripting Capabilities (UG894) at the location cited under References in Additional Resources at the end of this document.

Design Data Flow – Top Level Floorplan

When you integrate RTL into a design, it helps to visualize the design inside the device. Graphically seeing how the blocks interconnect between themselves and the IO pinout after synthesis helps you to understand your design.

To view the interconnect, generate a top level floorplan using Pblocks on upper levels of hierarchy. To break apart the top level RTL into Pblocks, select Tools > Floorplanning > Auto Create Pblocks.

To place the blocks in the device, select Tools > Floorplanning > Place Pblocks. The tool sizes the Pblocks based on the slice count and target utilization.

Pblocks can be more than one hundred percent full during analysis, but not during implementation. Overfilling the Pblock makes them smaller on the device. This is a useful technique for understanding a full device.
The top level floorplan shows which blocks communicate with IOs (green lines). Nets shared between two Pblocks are bundled together. The bundles change size and color based on the number of shared nets. Two top level floorplans are shown below.

**Figure 38: Place Pblocks Utilization**

<table>
<thead>
<tr>
<th>Place</th>
<th>Pblock</th>
<th>Utilization %</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>pblock_1</td>
<td>300</td>
</tr>
<tr>
<td></td>
<td>pblock_2</td>
<td>300</td>
</tr>
<tr>
<td></td>
<td>pblock_arnd1</td>
<td>300</td>
</tr>
<tr>
<td></td>
<td>pblock_arnd2</td>
<td>300</td>
</tr>
<tr>
<td></td>
<td>pblock_arnd3</td>
<td>300</td>
</tr>
<tr>
<td></td>
<td>pblock_arnd4</td>
<td>300</td>
</tr>
</tbody>
</table>

[Image of the schematic]
Data Path Top Level Floorplan

Figure 39: Data Path Top Level Floorplan

The Data Path Top Level Floorplan shows a data path. Each block communicates only to a drive block and a load block. The green lines show well-placed IOs that communicate with a single block. This design is easy to floorplan.
The Control Path Floorplan displays a design in which all the blocks communicate with a central block. The largest connection is between the central block and the block in the bottom right. The central block must spread out around the design to communicate with all the other loads. This design is hard to floorplan.

Reviewing the Floorplan

Consider device resources when reviewing the floorplan. The Pblock sizing does not take into account specialized device resources such as:

- Block RAM
- DSP48s
- MGTs
- ClockBuffers

Review the blocks with the floorplan and utilization in mind.

Analyzing Device Utilization Statistics

A common cause of implementation issues comes from not considering the logic and device layout implied by the pinout. Slice logic is uniform in most devices. However specialized resources such as the following impact logic placement:

- IO
- High Performance Banks
- High Range Banks
- MGT
- DSP48
- Block RAM
- MMCM
- BUFG
- BUFR

Blocks that are large consumers of a certain specialized resource may have to spread around the device. Take this into account when designing the interface with the rest of the design. Use a combination of the following to find block resources:

- `report_utilization`
- `netlist properties`
- `Pblock properties`
DRCs

DRCs check the design and report on common issues. Run DRCs using the `report_drc` command. During implementation, the tools also run DRCs. The DRCs become more complete and comprehensive with placement and routing.

![DRC example](image)

**Figure 41: Showing Critical Warnings and Error**

**RECOMMENDED:** Review the DRC messages, Critical Warnings, and Warnings early in the flow to prevent issues later.

At Synthesized Design, the optional Report DRC step reports a Critical Warning for the unconstrained IOs. The routed design DRC report reports the Critical Warnings. You must review the report. At `write_bitstream`, the DRC has been elevated to an Error. Review the DRC reports early to identify areas of the design that need modification.

Multiple Designs

A Design is an in-memory combination of a:

- Netlist
- Constraint set
  - The constraint set is a set of XDC constraint files with the target file marked for new constraints.
- Part
  - The tool supports multiple designs open at the same time. When analyzing code, it can be useful to have the Elaborated Design open at the same time as the Implemented Design. It is also possible to have multiple designs open at the same step of the flow.
The **Make Active** link appears in designs using the non-default settings. Click **Make Active** to update the defaults.

Use this feature to compare:
- Multiple different synthesis runs
- Constraint file iterations
- Different parts for the same netlist
- Two different Place and Router results

This feature works best on a 64-bit operating system. A simple way to open multiple designs is to open two runs at the same step. A more advanced method involves opening the single netlist in multiple windows:

1. Right click Synthesized Design.
2. Choose **New Synthesized Design** from the popup menu.

Elaborated Design supports a similar method.
Non-project mode has a similar state. An easy way to get into this state is to open multiple checkpoints without closing either. Run `close_design` to close a checkpoint before opening a second one. It is easiest to run the `start_gui` command and manage the multiple designs using the Vivado IDE graphical user interface.

**Multiple Windows**

Users with multiple monitors can float windows or designs. To open an entire Design in a different window (for example, when you have multiple Synthesized Designs open and you want to view them simultaneously), right click the blue Design bar. Select **Open in New Window** from the popup menu.
For information on floating an individual window from a design, see Using Windows in the *Vivado Design Suite User Guide: Using the Vivado IDE (UG893)* at the location cited under References in Additional Resources at the end of this document.
Chapter 3

Analyzing Implementation Results

This chapter discusses techniques for reviewing a design after implementation to understand behavior inside the device, including:

- Reviewing placement for hierarchical blocks
- IOs
- Looking at connectivity
- Cross probing between views
- Reviewing detailed routing

Design Runs Window

The Design Runs window displays the state of the current runs.

For more information, see Using the Design Runs Window in the Vivado Design Suite User Guide: Implementation (UG904) at the location cited under References in Additional Resources at the end of this document.

If the run is running, finished cleanly, or finished with errors, the Design Runs window appears when a run is done.

**TIP:** If the run is not up to date, select **Force up to date** from the popup menu.

![Figure 45: Design Runs Window](image-url)
The Design Runs Window does the following:

- Displays the message `route_design Complete`!
- Gives a brief summary.
- Reports any design error.
- Does not report whether the design met timing.
- Does not report Critical Warnings or other design issues.

If you are using the Vivado™ IDE project flow, review the Messages tab for your active implementation. Messages are grouped by each step in the run flow. The critical information from the implementation steps appears in this view. See the message in the log file to view the context.

![Messages Grouped by Step](Image)

**Figure 46: Messages Grouped by Step**

If there are warnings or errors, review one of the reports listed above for more information. Some messages crossprobe back to the design elements related to the message.

To analyze the design in the context of the message, you might need to open either:

- Implemented Design (using the netlist at the end of implementation), or
- Netlist Design (using the netlist before implementation)
The router gives a message if a design met timing or not.

**IMPORTANT:** The router is not sign off timing. Only `report_timing_summary` is sign off timing.

Review the Timing Summary Report to determine if the design meets timing. If it did not meet timing, review the timing closure techniques discussed in *Chapter Five: Closure Techniques*.

In the non-project flow (provided that the Vivado IDE graphical user interface is open), messages generated during that executable session still show in the Messages Window. Otherwise, review the following:

- Vivado IDE log
- Notes, Warnings and Errors

If you are running without the Vivado IDE graphical user interface, run the TCL `report_timing_summary` command to determine if the design met timing.

### More Analysis

After implementation finishes, you may want to analyze the design to see how it interacts with the device. The Vivado IDE has a number of metrics to help you determine logic and routing usage inside the device. The Metrics color code the device window based on a specified rule.
Figure 48: Metrics
Metrics Requiring a Placed Design

Four metrics require a placed design in order to be accurate. They do not require a fully routed design.

- **LUT Utilization per CLB**
  Color codes slices based on placed LUT utilization.

- **FF Utilization per CLB**
  Color codes slices based on placed FF utilization.

- **Vertical Routing Congestion per CLB**
  Color codes the fabric based on a best case estimate of vertical routing usage.

- **Horizontal Routing Congestion per CLB**
  Color codes the fabric based on a best case estimate of horizontal routing usage.

Metrics in a Netlist Design With No Placement

Two metrics are applicable if there are Pblocks. They do not depend on placement.

- **LUT Utilization per Pblock**
  Color codes the Pblock based on an estimate of how the LUTs will be placed into the slices contained in the Pblock.

- **FF Utilization per Pblock**
  Color codes the Pblock based on an estimate of how the FFs will be packed into the slices contained in the Pblock.

More than one rule can be used at a time as shown in the figure above (Metrics). Both LUT Utilization per CLB and FF Utilization per CLB are on.

---

**TIP:** If there are sections of the design with high utilization or high estimates of routing congestion, consider tweaking the RTL or placement constraints to reduce logic and routing utilization in that area.

---

**Highlight Placement**

Another way to review design placement is to analyze cell placement. The **Highlight Primitives** command helps in this analysis.

1. In the Netlist Window, select the levels of hierarchy to analyze.
2. From the popup menu, select **Highlight Primitives > Select a color**.
3. If you select multiple levels of hierarchy, select **Cycle Colors**.

The primitives that make up the cells are color coded in the Device window.
The color coding readily shows that $\text{UsbEngine0}$ (in yellow):

- Uses a number of Block RAM and DSP48 cells.
- Is in the top clock region of the chip except where the DSPs bleed out.
- Is not highly intermingled with other logic (cells) in the design.

It is easy to see that the $\text{fftEngine}$ (in red) and the $\text{cpuEngine}$ (in brown) are intermingled. The two blocks primarily use different resources (DSP48 as opposed to slices). Intermingling makes best use of the device.

**Show Connectivity**

It can be useful to analyze a design based on connectivity. You might want to review the placement of all the logic driven by an input, a Block RAM, or a bank of DSPs. Run the **Show Connectivity** command for this purpose. **Show Connectivity** takes a set of cells or nets as a seed, and selects objects of the other type. Use this technique to build up and see cones of logic inside the design.
Figure 50: Show Connectivity
The figure above (Show Connectivity) shows a Block RAM driving logic inside the device including OBUFs. A synthesis pragma stops synthesis from placing the output flop in the Block RAM during memory inferencing.

Fixed and Unfixed Logic

The tool tracks two different types of placement:

- Elements placed by the user (shown in orange) are **Fixed**.
  - Fixed logic is stored in the XDC.
  - Fixed logic normally has a LOC constraint and might have a BEL constraint.
- Elements placed by the tool (shown in blue) are **Unfixed**.
The IO and Block RAM placement is **Fixed**. The slice logic is **Unfixed**.
Fixing Logic

To fix logic:
1. Enter placement into the XDC.
2. Select logic in the Vivado IDE graphical user interface.
3. From the popup, select Fix Instances, or
4. Set the is_loc_fixed or is_bel_fixed properties in the TCL console.

In the XDC, the constraints look like the following.

- For a Flip Flop with a LOC and BEL

```tcl
set_property BEL DFF [get_cells {cpuEngine/cpu_iwb_dat_i/buffer_fifo/infer_fifo.wr_addr_tmp_reg[9]}]
set_property LOC SLICE_X7Y103 [get_cells {cpuEngine/cpu_iwb_dat_i/buffer_fifo/infer_fifo.wr_addr_tmp_reg[9]}]
```

Flip Flops can be placed with only a LOC.

- For a Block RAM

```tcl
set_property LOC RAMB36_X0Y21 [get_cells usbEngine1/dma_out/buffer_fifo/infer_fifo.block_ram_performance.fifo_ram_reg]
```

- For an IO Pin

```tcl
set_property PACKAGE_PIN E23 [get_ports {DataIn_pad_0_i[5]}]
```

Cross Probing

For designs synthesized with Vivado Synthesis, it is possible to cross probe back to the source files once the netlist design is in memory.

To cross probe:

1. Select the gate.
2. Select Go to instantiation from the popup menu.
Use crossprobing to determine which source is involved in netlist gates. Due to the nature of synthesis transforms, it is not possible to cross probe back to source for every gate in the design.
Viewing Routing

Turn on **Routing Resources** in the Device View to view the exact routing resources.

![Figure 53: Enable Routing](image)

Displaying Routing and Placement

Routing and placement display in two different ways depending on the zoom level:

- When zoomed out
- At closer zoom levels

The two visualizations of the Device view minimize runtime and memory usage while showing the details of designs of all sizes.

Displaying Routing and Placement When Zoomed Out

When zoomed out, an abstract view is shown. The abstract view:

- Condenses the routes through the device.
- Shows lines of different thicknesses depending on the number of routes through a particular region.

Placement similarly displays a block for each tile with logic placed in it. The more logic in a tile, the larger the block representing that tile will be.
Displaying Routing and Placement at Closer Zoom Levels

At closer zoom levels, the actual logic cells and routes show.

Figure 54: Abstract View

Figure 55: Detailed View
Viewing Options

The Device View is customizable to show the device, and design, in a variety of ways. Most of these are controlled through the Device View Options slideout.

You can enable or disable the graphics for different design and device resources, as well as modify the display colors.
Navigating in the Device View

Use the following tools to navigate in the Device View.

- **Zoom Controls**
  Standard Zoom In, Zoom Out, and Zoom Full tools.

- **Autofit Selection**
  Automatically zoom and pan to an object selected in any view outside of the device. Autofit Selection is particularly useful for cross probing.

- **World View**
  The World View shows where the currently visible portion of the device is on the overall device. You can move and resize the World View, as well as drag and resize the yellow box to zoom and pan.

- **Control Hotkey**
  Press **Ctrl** while clicking and dragging to pan the view.
Chapter 4

Timing Analysis

Introduction to Timing Analysis

The Vivado™ Design Suite provides several reporting commands you can run to verify that your design meets all the timing constraints and is ready to be loaded on the application board. Report Timing Summary is the timing signoff report, equivalent to TRCE in the ISE™ Design Suite. It provides a comprehensive overview of all the timing checks and shows enough information to start analyzing and debugging any timing issue. For more information, see Chapter 1, Design Analysis.

You can generate this report in a window, write it to a file or simply print it in your log file. Whenever Report Timing Summary shows that your design does not meet timing or is missing some constraints, you can explore the details provided in the various sections of the summary and run more specific analysis depending on the nature of the problem. The other timing reports provide more details on a particular situation or to scope the analysis to some logic by using filters.

Verifying Timing Signoff

Before going into the details of timing analysis, it is important to understand which part of the timing reports indicates that your design is ready to run in hardware. Timing signoff is a mandatory step in the analysis of the implementation results, once your design is fully placed and routed.

By default, when using projects in the Vivado Design Suite, the runs automatically generate the text version of Report Timing Summary. You can also generate this report interactively after loading the post-implementation design checkpoint in memory.

Timing Signoff Criteria

Timing signoff is the combination of two criteria:

- Your design is fully constrained
- Your design meets timing
Your Design Is Fully Constrained

You can verify that your design is fully constrained by looking at the Check Timing section. Check Timing must show that:

- All non-constant clock pins are reached by a defined clock (no_clock check).
- All internal path endpoints are timed (unconstrained_endpoint check).
- All input and output ports are constrained (no_input_delay, no_output_delay checks).

You can waive some of the missing constraints, at the risk of lowering the signoff quality of your design. You also need to review the result of the other checks to make sure that they are expected and they do not affect the signoff quality.

Your Design Meets Timing

- Total Negative Slack (TNS) is 0ns. This covers max delay analysis.
- Total Hold Slack (THS) is 0ns. This covers min delay analysis.
- Total Pulse Width Slack (TPWS) is 0ns. This is equivalent to Component Pin Switching Limit in ISE. It is performed with both min and max delays.

The sum of TNS, THS and TPWS is equivalent to the ISE final Timing Score.

Verifying Clean Timing Signoff

The following figure (Report Timing Summary Signoff in Vivado IDE) highlights in green the information you must look at first in order to verify that the timing signoff is clean.

![Figure 58: Report Timing Summary Signoff in Vivado IDE](image_url)
The following figure (Check Timing Signoff in Text Report) shows the Check Timing information to verify in the text report.

![Figure 59: Check Timing Signoff in Text Report](image)

The following figure (Design Timing Summary Signoff in Text Report) shows the Design Timing Summary information to verify in the text report.

![Figure 60: Design Timing Summary Signoff in Text Report](image)

**Investigating Timing Violations**

In the Vivado IDE, slack violations are reported in red. Missing constraints are not highlighted with a particular color. To investigate timing violations, review the following sections:

- The Intra-Clock Paths, Inter-Clock Paths and Path Groups (**async_default**) sections provide information on setup and recovery and hold and removal violations.

- Intra-Clock Paths provides details on Pulse Width check violations.
For more information on the report windows, see Timing Summary Report in *Chapter 1, Design Analysis*.

**TIP:** To display violations only, click the **Show only failing checks** button.

If you used the default options, the Timing Summary report includes the details of the N-worst paths for each clock pair and for each type of analysis. The GUI default for \( N \) is 10 (ten), and the `report_timing_summary` command default for \( N \) is 1 (one).

You can directly look into the timing path details without running another report by double-clicking on the path. If not enough paths are reported, you can either re-run Report Timing Summary with more paths (Tcl equivalent: `report_timing_summary -max_paths N`) or simply run Report Timing on a particular clock pair or a particular timing path.

---

**Reading a Timing Path Report**

The timing path report provides the information needed to understand what causes a timing violation. The following sections describe the Timing Path Report.

**Timing Path Summary**

The Timing Path Summary is where the important information from the timing path details is gathered. You can review it to find out about the cause of a violation without having to analyze the details of the timing path. It includes slack, path requirement, datapath delay, cell delay, route delay, clock skew and clock uncertainty. It does not provide any information about cell placement.

For more information about the terminology used for timing constraints and timing analysis, as well as learn how slack and path requirement are determined, see Timing Analysis in the *Vivado Design Suite Using Constraints User Guide* (UG903) at the location cited under References in Additional Resources at the end of this document.
Timing Path Summary Header Examples

The following figure (Timing Path Summary In Text Report) shows an example of the Timing Path Summary Header in a text report.

![Figure 61: Timing Path Summary In Text Report](image)

The following figure (Timing Path Summary in Vivado IDE) shows an example of the Timing Path Summary header in the Vivado IDE.

![Figure 62: Timing Path Summary in Vivado IDE](image)

Timing Path Summary Header Information

The Timing Path Summary header includes the following information:

- **Slack**: A positive slack indicates that the path meets the path requirement, which is derived from the timing constraints. The Slack equation depends on the analysis performed:
  - **Max delay analysis (setup/recovery)**:
    \[
    \text{slack} = \text{data required time} - \text{data arrival time}
    \]
  - **Min delay analysis (hold/removal)**:
slack = data arrival time - data required time

Data required and arrival times are calculated and reported in the other sub-sections of the timing path report.

- **Source**: Shows the path startpoint and the source clock that launches the data. The startpoint is usually the clock pin of a sequential cell or an input port.
  
  When applicable, the second line displays the primitive and the edge sensitivity of the clock pin. It also provides the clock name and the clock edges definition (waveform and period).

- **Destination**: Shows the path endpoint and the destination clock that captures the data. The endpoint is usually the input data pin of the destination sequential cell or an output port. Whenever applicable, the second line displays the primitive and the edge sensitivity of the clock pin. It also provides the clock name and the clock edges definition (waveform and period).

- **Path Group**: Shows the timing group that the path endpoint belongs to. This is usually the group defined by the destination clock, except for asynchronous timing checks (recovery/removal) which are grouped in the **async_default** timing group. User-defined groups can also appear here. They are convenient for reporting purpose.

- **Path Type**: Shows the type of analysis performed on this path. “Max” indicates that the maximum delay values are used to calculate the data path delay, which corresponds to setup and recovery analysis. “Min” indicates that the minimum delay values are used to calculate the data path delay, which corresponds to hold and removal analysis. This line also shows which corner was used for the report: Slow or Fast.

- **Requirement**: Shows the timing path requirement, which is typically one clock period for setup/recovery analysis and 0ns for hold/removal analysis when the startpoint and endpoint are controlled by the same clock. When the path is between two different clocks, the requirement corresponds to the smallest positive difference between any source and destination clock edges. This value is overridden by timing exception constraints such as multicycle path, max delay and min delay.

  For more information on how timing path requirement is derived from the timing constraints, see Timing Analysis in the *Vivado Design Suite User Guide Using Constraints (UG903)* at the location cited under References in Additional Resources at the end of this document.

- **Data Path Delay**: Shows accumulated delay through the logic section of the path. The clock delay is excluded unless the clock is used as a data. The type of delay corresponds to what the “Path Type” line describes.

- **Logic Levels**: Shows the number of each type of primitives included in the data section of the path, excluding the startpoint and the endpoint cells.

- **Clock Path Skew**: Shows the insertion delay difference between the launch edge of the source clock and the capture edge of the destination clock, plus clock pessimism correction if any.
• **Destination Clock Delay (DCD)**: Shows the accumulated delay from the destination clock source point to the endpoint of the path. For max delay analysis (setup/recovery), the minimum cell and net delay values are used, while for min delay analysis (hold/removal), the maximum delay values are used.

• **Source Clock Delay (SCD)**: Shows that accumulated delay from the clock source point to the startpoint of the path. For max delay analysis (setup/recovery), the maximum cell and net delay values are used, while for min delay analysis (hold/removal), the minimum delay values are used.

• **Clock Pessimism Removal (CPR)**: Shows the absolute amount of extra clock skew introduced by the fact that source and destination clocks are reported with different types of delay even on their common circuitry. After removing this extra pessimism, the source and destination clocks do not have any skew on their common circuitry. For a routed design, the last common clock tree node is usually located in the routing resources used by the clock nets and is not reported in the path details.

• **Clock Uncertainty**: Shows the total amount of possible time variation between any pair of clock edges. The uncertainty comprises the computed clock jitter (system and discrete), the phase error introduced by certain hardware primitives and any clock uncertainty specified by the user in the design constraints (set_clock_uncertainty). The user clock uncertainty is additive to the uncertainty computed by the Vivado timing engine.

• **Total System Jitter (TSJ)**: Shows the combined system jitter applied to both source and destination clocks. You can modify the system jitter globally by running the `set_system_jitter` XDC command. The virtual clocks are ideal and therefore do not have any system jitter. For more information on System Jitter, see the *Vivado Design Suite User Guide: Using Constraints (UG903)* at the location cited under References in Additional Resources at the end of this document.

• **Total Input Jitter (TIJ)**: Shows the combined input jitter of both source and destination clocks. You can define the input jitter for each primary clock individually by using the `set_input_jitter` XDC command. The Vivado IDE timing engine computes the generated clocks input jitter based on their master clock jitter and the clocking resources traversed. By default, the virtual clocks are ideal and therefore do not have any jitter. For more information on jitter, see the *Vivado Design Suite User Guide: Using Constraints (UG903)* at the location cited under References in Additional Resources at the end of this document.

• **Discrete Jitter (DJ)**: Shows the amount of jitter introduced by hardware primitives like the MMCM or the PLL. The Vivado timing engine computes this value based on the configuration of these cells.

• **Phase Error (PE)**: Shows the amount of phase variation between two clock signals introduced by hardware primitives like the MMCM and the PLL. The Vivado timing engine automatically provides this value and adds it to the clock uncertainty.
• **User Uncertainty (UU):** Shows the additional uncertainty specified by the set_clock_uncertainty XDC command. For more information on how to use this command, see the *Vivado Design Suite User Guide: Using Constraints (UG903)* at the location cited under References in Additional Resources at the end of this document.

Three other lines can appear in the Timing Path Summary depending on the timing constraints, the reported path and the target device:

• **Inter-SLR Compensation:** Shows the additional margin required for safely reporting paths that cross SLR boundaries in Xilinx® 7 series SSI devices only.

• **Input Delay:** Shows the input delay value specified by the set_input_delay XDC command on the input port. This line does not show for paths that do not start from an input port.

• **Output Delay:** Shows the output delay value specified by the set_output_delay XDC command on the output port. This line does not show for paths that do not end to an output port.

• **Timing Exception:** Shows the timing exception that covers the path. Only the exception with the highest precedence is displayed, as it is the only one affecting the timing path requirement. For more information on timing exceptions and their precedence rules, see the *Vivado Design Suite User Guide: Using Constraints (UG903)* at the location cited under References in Additional Resources at the end of this document.

### Timing Path Details

The second half of the report provides more details on the cells, pins, ports and nets traversed by the path. It is separated into three sections:

• **Source Clock Path:** Shows the circuitry traversed by the source clock from its source point to the startpoint of the datapath. This section does not exist for a path starting from an input port.

• **Data Path:** Shows the circuitry traversed by the data from the startpoint to the endpoint.

• **Destination Clock Path:** Shows the circuitry traversed by the destination clock from its source point to the datapath endpoint clock pin.

The Source Clock Path and Data Path sections work together. They are always reported with the same type of delay: max delay for setup/recovery analysis, and min delay for hold/ removal analysis. They share the accumulated delay which starts at the data launch edge time, and accumulates delay through both source clock and data paths. The final accumulated delay value is called the data arrival time.

The destination clock path is always reported with the opposite delay to the source clock and data paths. Its initial accumulated delay value is the time when the data capture edge is launched on the destination clock source point. The final accumulated delay value is called the data required time.
The last three lines of the report summarize how the slack is computed.

- For max delay analysis (setup/recovery):
  \[ \text{slack} = \text{data required time} - \text{data arrival time} \]

- For min delay analysis (hold/removal):
  \[ \text{slack} = \text{data arrival time} - \text{data required time} \]

Timing Path Details In Text Report

The following figure (Timing Path Details In Text Report) shows an example of the Source Clock, Data and Destination Clock Paths in the text report. The path is covered by a simple period constraint of 5ns, which is why the source clock launch edge starts at 0ns and the destination clock capture edge starts at 5ns.

![Figure 63: Timing Path Details In Text Report](image)

Timing Path Details in Vivado IDE

The Timing Path Details in Vivado IDE figure (immediately below) shows the same example as the Timing Path Details In Text Report figure (immediately above).
The information on the path is presented in five columns:

- **Location**: Shows where the cell or port is placed on the device.
- **Delay Type**: Shows the unisim primitive and the particular timing arc followed by the path. In case of a net, it shows the fanout \((fo)\) and its status. A net can be:
  - **Unplaced**: The driver and the load are not placed.
  - **Estimated**: The driver or the load or both are placed. A partially routed net is also reported as estimated.
  - **Routed**: The driver and the load are both placed, plus the net is fully routed.
- **\(\text{Incr}(\text{ns})\) (text report) / Delay (IDE report)**: Shows the value of the incremental delay associated to a unisim primitive timing arc or a net. It can also show of a constraint such as input/output delay or clock uncertainty.
• **Path(ns) (text report) / Cumulative (IDE report):** Shows the accumulated delay after each segment of the path. On a given line, its value is the accumulated value from the previous + the incremental delay of the current line.

• **Netlist Resource(s) (text report) / Logical Resource (IDE report):** Shows the name of the netlist object traversed.

Each incremental delay is associated to an edge sense: \( r \) (*rising*) or \( f \) (*falling*). The initial sense of the edge is determined by the launch or capture edge selected for the path. It can be transformed by any cell along the path, depending on the nature of the timing arc. For example, a rising edge at the input of an inverter becomes a falling edge on the output. The edge sense can be very helpful to identify that an overly tight timing path requirement comes from a clock edge inversion along the source or destination clock tree.
Introduction to Closure Techniques

This chapter discusses techniques for timing closure including:

- Refining timing constraints
- Floorplanning
- Making the implementation tools work harder
- Automatic and manual ways to improve design timing

Check Input Constraints and Sources

Ensure that design and timing inputs are reasonable.

- Be sure that you have a good netlist.
  
  If you are using Vivado™ Synthesis, add synthesis-specific timing constraints to a synthesis XDC file. Synthesis is timing-driven, and can tune the gates to meet timing.

- Manually review the clock trees in the Schematic window or the Clock Networks window.
  
  Be sure that the clock trees are reasonable. Designs can hit long clock skew when one BUFG drives a second BUFG or a LUT. The extra clock skew can lead to tight hold timing constraints, degrading system timing. The placer DRCs issue warnings for some clock tree issues.

- Consider the clocking resources when laying out the pinout and floorplanning the design.
  
  The clock regions in Xilinx® 7 series FPGFA devices support twelve global clocks per region. There are additional limitations on the placement of clock trees.

- Be sure that the clock periods are the ones the design needs to meet.
  
  If you are over constraining the design, the tools will try to hit artificially tight timing constraints at the cost of runtime. Overconstraining can lead to timing failures and higher power consumption.
If the design is failing to meet artificially tight constraints, try the real constraints. You can modify timing constraints in the Vivado IDE without changing the placement and routing. Re-run `report_timing_summary` with the real clock periods.

- **Determine if the failing paths are multi-cycle paths or false paths.**
  
  For XDC, the tool assumes that all cross clock domain crossings are real paths. This is a change from ISE and UCF. Other paths may not be reachable due to the structure of the control logic. Enter False Path Timing constraints.

- **Other control structures (for example, a clock enable driven by a state machine) generate multi-cycle paths.** Data has multiple clock periods to get from the source to the destination. Enter Multi-cycle Timing constraints.

- **You can re-run timing after Implementation with the improved timing constraints.** You do not need to re-run implementation to see how changing the timing graph changes design timing. Review the next set of timing paths and continue to refine the timing constraints as needed.

- **If you are still not meeting timing after modifying the timing constraints, re-run implementation.** Implementation is timing-driven and can now focus on the real problem areas. If the original design had high Total Hold Slack (THS) in the router, you must re-run implementation.

**TIP:** Use **Save Constraints As** to create a new constraint set, preserving your original constraints.

- **Review the timing path.**
  
  Ensure that clock skew and jitter are reasonable.

- **Review the logic.**
  
  What is the logic delay compared to the period? If logic delay is a high percentage of the period you must resynthesize the design to reduce logic delay. Two ways to try to reduce logic delay are:

  - **Consider re-writing the RTL to reduce route delay.**
    
    If you see high fanout nets, consider replicating the drivers. When refactoring the high fanout net take placement into account. Each driver should communicate with localized loads rather than spread out loads.

  - **If route delay is a high percentage of the timing path consider floorplanning.**
    
    The goal is to improve the timing of the critical paths by reducing route delay. Floorplanning does not change the logic that makes up the critical path. Review how the blocks in the design interconnect while floorplanning. You may want to restructure the RTL to better work inside the device. The synthesis tools do not know about placement. When they replicate high fanout nets, they generally do not take placement into account.
Manually replicating and rewiring can lead to a better design. For example, if you have two memory interfaces that go on opposite corners of the chip, you might want to replicate the control signals in the RTL source. You might need to use synthesis attributes to stop optimization of logically equivalent registers.

Increasing Tool Effort

Ask the tools to work harder. Sometimes you can close timing on a design just by assigning more CPU cycles to implementation. Use the **HighEffort Strategy**. Implementation runs at a medium effort level by default. The `place_design` and `route_design` commands accept a `–effort_level high` switch. The tools will try different approaches to meet timing at the expense of runtime.

Consider using the **HighEffortPhysSynth** strategy. It turns up the effort level and turns on the optional `phys_opt_design` step. It works to improve timing at the expense of run time.

Run the **Flow > Create Runs** command to create and launch multiple runs using the different strategies.

---

**Figure 65: Multiple Runs**

Review the implementation results to find the strategy that works best for the design. Re-use the strategy for later runs.

**TIP:** The optimal strategy can change between designs and software releases.
Manual Floorplanning

Floorplanning can help a design meet timing. Floorplan when a design:

- Does not meet timing consistently.
- Has never met timing.

Floorplanning is also helpful when you are working with design teams, and consistency is most important.

Floorplanning can improve the setup delay (TNS WNS) by reducing route delay. During implementation, the timing engine reports on Setup, Hold, and Component Switching Limits. Floorplanning can only improve Setup slack.

Manual floorplanning is easiest when the netlist has hierarchy. Design analysis is much slower when synthesis flattens the entire netlist. Set up synthesis to generate a hierarchical netlist.

- For XST, use:
  - `keep_hierarchy=no (default) and -netlist_hierarchy = rebuilt (non-default),`
  - or the PlanAhead™ tool defaults strategy

- For Vivado Synthesis use:
  - `-flatten_hierarch = rebuilt, or the Vivado Synthesis Defaults strategy`

Large hierarchical blocks with intertwined logical paths can be difficult to analyze. It is easier to analyze a design in which separate logical structures are in lower sub-hierarchies. Consider registering all the outputs of a hierarchical module. It is difficult to analyze the placement of paths that trace through multiple hierarchical blocks.

Floorplanning Basics

Not every design will always meet timing. You may have to guide the tools to a solution. Floorplanning allows you to guide the tools, either through high level hierarchy layout, or through detailed gate placement.

Consider floorplanning to increase performance by reducing route delay or increasing logic density on a non-critical block. Logic density is a measure of how tightly the logic is packed onto the chip.

Floorplanning can help you meet a higher clock frequency and improve consistency in the results.

There are multiple approaches to floorplanning, each with its advantages and disadvantages.

Detailed Gate-Level Floorplanning

Detailed gate-level floorplanning involves placing individual logic elements in specific sites on the device.
Advantages of Detailed Gate-Level Floorplanning

- Detailed gate-level floorplanning works with hand routing nets.
- Detailed gate-level floorplanning can extract the most performance out of the device.

Disadvantages of Detailed Gate-Level Floorplanning

- Detailed gate-level floorplanning is time consuming.
- Detailed gate-level floorplanning requires extensive knowledge of the device and design.
- Detailed gate-level floorplanning may need to be redone if the netlist changes.

**RECOMMENDED:** Use detailed gate-level floorplanning as a last resort.

Information Re-Use

Re-use information from a design that met timing. Use this flow if the design does not consistently meet timing. To re-use information:

1. Open two implementation runs:
   - One for a run that is meeting timing.
   - One for a run that is not meeting timing.

   **TIP:** On a computer with multiple monitors, select Open Implementation in New Window to open a design in a new window. For more information, see Multiple Windows.

2. Look for the differences between the two designs.
   - Identify some failing timing paths from report_timing_summary.
   - On the design that is meeting timing, run report_timing in min_max mode to time those same paths on the design that meets timing.

3. Compare the timing results:
   - clock skew
   - logic delay
   - placement
   - route_delays

4. If there are differences in the amount of logic delay between path end points, revisit the synthesis runs.
Review Element Placement

Review the placement of the elements in the design. Compare two IO reports to review the IO placement and IO standards. Make sure all the IOs are placed. A simple search finds all IOs without fixed placement as shown in the following figure (IO Is Not Fixed).

![Image of Find dialog box with criteria set to search for IOs not fixed]

Figure 66: IO Is Not Fixed

Consider placing all the clock primitives based on the run that met timing. The Clock Utilization Report lists the placement of the clock tree drivers, as shown in the following figure (Clock Locations).
The LOC constraints can easily copied into your XDC constraints file.

Many designs have met timing by reusing the placement of the Block RAMs and DSPs. Select **Edit > Find** to list the instances.

![Figure 68: DSP or RAM](image)

Design Analysis and Closure Techniques  www.xilinx.com  99
UG906 (v 2012.3) November 16, 2012
Adding Placement Constraints

Fix the logic to add the placement constraints to your XDC.
1. Select the macros from the find results.
2. Right click.
3. Select **Fix Instances**.

![Figure 69: Selecting the Logic to Fix](image)

**RECOMMENDED:** Analyze the placement based on hierarchy name and highlight before fixing the placement.

Re-Using Placement

It is fairly easy to re-use the placement of:
- IOs
- Global Clock Resources
- BlockRam
- DSP macros

Re-using this placement helps to reduce the variability in results from one netlist revision to the next. These primitives generally have stable names. The placement is usually easy to maintain.
**TIP:** Do not reuse the placement of general slice logic. Do not re-use the placement for sections of the design that are likely to change.

**Hand Floorplanning**

Consider gate floorplanning for a design that has never met timing, and in which changing the netlist or the constraints are not good options.

**RECOMMENDED:** Try hierarchical floorplanning before considering gate level floorplanning.

**Hierarchical Floorplanning**

Hierarchical floorplanning allows you to place one or more levels of hierarchy in a region on the chip. This region provides guidance to the placer. The placer does the detailed placement.

Hierarchical floorplan creation is fast compared to gate floorplanning. A good floorplan can improve timing. The floorplan is resistant to design change.

The level of hierarchy acts as a container for all the gates. It will generally work if the netlist changes.

**Hand Gate Placement**

Hand gate placement can obtain the best performance from a device. When using this technique, designers generally use it only on a small block of the design. They may hand place a small amount of logic around a high speed IO interface, or hand place Block RAMs and DSPs. Hand placement can be slow.

All floorplanning techniques can require significant engineering time. They may require floorplan iterations. If any of the gate names change, the floorplan constraints must be updated.

In hierarchical floorplanning:

- Identify the lower levels of hierarchy that contain the critical path.
- Use the top level floorplan to identify where to place them.
- Implementation places individual gates.
- Has comprehensive knowledge of the gates and timing paths.
- Generally does a good job of fine grain placement.

When floorplanning, you should have an idea of final pinout. It is useful to have the IOs fixed. The IOs can provide anchor points for starting the floorplan. Logic that communicates to IOs migrates towards the fixed pins.
TIP: Place blocks that communicate with IOs near their IOs. If the pinout is pulling a block apart, consider pinout or RTL modification.
Figure 70: IO Components Pulling Design Apart
The floorplan shown in the figure above (IO Components Pulling Design Apart) may not help timing. Consider splitting the block apart, changing the source code, or constraining only the Block RAMs and DSPs.

The Pblock above is represented by the XDC constraints:

```
create_Pblock Pblock_fftEngine
add_cells_to_Pblock [get_Pblocks Pblock_fftEngine] [get_cells -quiet [list usbEngine1]]
resize_Pblock [get_Pblocks Pblock_fftEngine] -add {SLICE_X8Y105:SLICE_X23Y149}
resize_Pblock [get_Pblocks Pblock_fftEngine] -add {DSP48_X0Y42:DSP48_X1Y59}
resize_Pblock [get_Pblocks Pblock_fftEngine] -add {RAMB18_X0Y42:RAMB18_X1Y59}
resize_Pblock [get_Pblocks Pblock_fftEngine] -add {RAMB36_X0Y21:RAMB36_X1Y29}
```

There is one line assigning the level of hierarchy to the Pblock. There are four resource types each with its own grid. Logic that is not constrained by a grid can go anywhere in the device. To constrain just the Block RAMs in the level of hierarchy, disable the other Pblock grids.
The resulting XDC constraints the simplified Pblock:

```vhdl
create_Pblock Pblock_fftEngine
add_cells_to_Pblock [get_Pblocks Pblock_fftEngine] [get_cells -quiet [list usbEngine1]]
resize_Pblock [get_Pblocks Pblock_fftEngine] -add {RAMB18_X0Y42:RAMB18_X1Y59}
resize_Pblock [get_Pblocks Pblock_fftEngine] -add {RAMB36_X0Y21:RAMB36_X1Y29}
```

The Block RAMs are constrained in the device, but the slice logic is free to migrate to the IOs.

**TIP:** When floorplanning logic, be careful not to floorplan hierarchy in such a manner that it crosses the central config block.
Stacked Silicon Interconnect (SSI)

There are extra considerations for Stacked Silicon Interconnect (SSI) parts. The SSI parts are made of multiple die or Super Logic Regions (SLRs), joined by an interposer. The interposer connections are called Super Long Lines (SLLs). There is some delay when crossing from one SLR to another.

Keep the SLRs in mind when structuring the design, generating a pinout, and floorplanning. Minimize SLL crossings by keeping critical timing paths inside an SLR.
The IOs are placed in the same SLR as the relevant IO interface. You should also consider clock placement when laying out logic for SSI parts.

**RECOMMENDED:** Let the placer try an automatic placement of the logic into the SSI parts before doing extensive partitioning. Analyzing the automatic placement may suggest floorplanning approaches you were not considering.
Modify Routing

Depending on results, you may want to modify routes. The Device View allows you to Unroute, Route, and Fix Routing on any individual net. These commands are available from the context menu on a net.

Figure 74: Net Context

Because only the commands applicable to a net are shown, not all commands are shown for all nets.
Modify Logic

Properties on logical objects that are not Read Only can be modified after Implementation in the Vivado IDE graphical user interface as well as Tcl. Select the Attributes tab in the Properties window.

![Figure 75: Property Modify](image)

These properties can include everything from Block RAM INITs to the clock modifying properties on MMCMs. There is also a special dialog box to set or modify INIT on LUT objects. This dialog box allows you to specify the LUT equation and have the tool determine the appropriate INIT.
Using Modifications

Once modified, a checkpoint is the recommended way to capture the design in memory. Because logical changes are not back-annotated to the logical design, you must make the logical modifications in Source or XDC for them to impact the next run.

Figure 76: Equation Editor
Appendix A

Additional Resources

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see the Xilinx® Support website at:

www.xilinx.com/support

For a glossary of technical terms used in Xilinx documentation, see:

www.xilinx.com/company/terms.htm

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual property at all stages of the design cycle. Topics include design assistance, advisories, and troubleshooting tips.

References

These documents provide supplemental material useful with this guide:

Vivado Design Suite 2012.3 Documentation,